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Section 1.0 Description 

1.1 Introduction 

The information in this section contains a product description and outlines the software features of the 
Master Caution Panel Data Acquisition Software (MCP-DAS).  

1.2 Product Description 

MCP-DAS is a Microsoft Windows based software program, developed for the purpose of acquiring and 
graphically displaying the data received from an AEM Master Caution Panel (MCP). 

The MCP-DAS is available for download from www.aem-corp.com. 

Review and Acceptance of the End User License Agreement is required before downloading the MCP-
DAS program. 

1.3  Software Features 

MCP-DAS can acquire and display both the data stored within the MCP, as well as the Real-Time data 
sent from the MCP. 

The displayed data can be saved to file and re-loaded into MCP-DAS at a later date for analysis. Data 
can also be exported to a CSV (Comma Separated Values) File for analysis. 

Signal names and colors can be customized in order to match the legend text found on the MCP.  

MCP-DAS can be used to edit the serial number of the MCP stored in memory. This is a factory only 
function and is password protected. 

1.4 Limitations of Use 

The data provided by MCP-DAS is intended for reference data analysis purposes only; it is not intended 
to be used solely for aircraft maintenance decisions. 

End of Section 1.0 
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Section 2.0 Installation 

2.1 Introduction  

The information in this section contains instructions for installing the MCP-DAS software. 

2.2 Required Accessories for Installation 

The equipment listed below is not supplied by AEM. 

Quantity Description AEM Part No.
1 Windows XP (32-bit)*, N/A 
 Windows 7 or 8 OS  

*Windows XP requires .NET framework version 2.0 to be installed.  

Note: An Internet connection is required for downloading software from www.aem-corp.com. 

2.3 Installation Procedure 

2.3.1 After downloading and uncompressing the zip file, initiate the installation by opening the 
setup.exe file. 

2.3.2  The Open File - Security Warning window may appear, select Run. 

Open File – Security Warning Window 
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2.3.3  A User Account Control window may appear, select Yes to allow the program to be 
installed on the computer. 

User Account Control Window 

           
2.3.4 A MCP-DAS Setup Wizard window will open, select Next to proceed. 

MCP-DAS Setup Wizard



MCP-DAS Data Acquisition Software 
Installation and Operation Manual 

November 14, 2014  Rev: 1.00 Page 2-3 
ENG-FORM: 805-0100.DOTX 

CONFIDENTIAL AND PROPRIETARY TO ANODYNE ELECTRONICS MANUFACTURING CORP.

2.3.5  Click Next to accept the specified installation path, or click Browse to select a different 
installation folder location, then select Next. 

Installation Destination Window 

2.3.6  Click Next to accept the specified Start Menu Folder, or click Browse to select a different 
Start Menu Folder, then select Next. 

Select a Start Menu Folder 
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2.3.7  Select the Create a desktop icon option if desired, select Next to proceed. 

Selecting Additional Tasks 

2.3.8  Click Install to continue with the installation or click Back to review or change any settings. 

Ready to Install Window 
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2.3.9  Click Finish to complete and exit the Setup. 

Setup Wizard Complete 

End of Section 2.0 
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Section 3.0 Operation 

3.1 Introduction 

Information in this section consists of functional and operational procedures for the AEM Master Caution 
Panel Data Acquisition Software (MCP-DAS). 

3.2 General 

MCP-DAS is a Microsoft Windows based software program developed for the purpose of acquiring and 
displaying the data received from an AEM Master Caution Panel (MCP). 

3.2.1 Functional Overview 

This section provides a brief overview of the various functions performed by MCP-DAS. Further sections 
will provide more detailed descriptions. 

MCP-DAS Main Program Window  
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Dump MCP EEPROM 

 Sends a request to the MCP to download the entire contents of the MCP State Recorder EEPROM. 
Received data is displayed in a new tab titled EEPROM X, where X is a sequential number which 
begins at 0 at the start of each new session. X represents the number of times an EEPROM Dump 
has been performed during each session. 

Real-Time Track 

 Displays data received from the MCP in real time in a tab titled Real-Time Data. 

Full View 

 Zooms out fully on the current tab. Used to display all possible data in the currently selected tab. 

Snapshot + Dump MCP EEPROM 

 Used for comparing Real-Time Data to EEPROM data. 

Snapshot + Dump performs two functions:  
1) Makes a copy of the current Real-Time Data and places it in a new tab titled Snapshot X.  
2) Sends a request to the MCP for the entire contents of EEPROM and displays the received data 

in a new tab titled EEPROM X. 

Logs and Configurations 

Data displayed in a tab can be saved and re-opened. Signal names and colors are editable and 
can also be saved and re-opened. 

Write Serial Number 

 The serial number stored in EEPROM is editable. This is a factory only function and is password 
protected. 

3.3 Required Accessories for Operation 

The equipment listed below is NOT supplied by AEM. 

Quantity Description AEM Part No.
1 Windows XP (32-bit)*,   
 Windows 7 or 8 OS N/A 
1 RS422 to USB Converter N/A
1 9-Pin Serial Cable N/A 
1 USB A to B Cable N/A 

*Windows XP requires .NET framework version 2.0 to be installed.  
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3.4 Operation 

3.4.1 Equipment Setup 

Setup the equipment as per the following: 
1) Ensure that the MCP unit is connected to either the aircraft wiring harness or to a test fixture. Apply 

power to the MCP. 
2) Connect the 9-pin Serial Cable between the MCP and the RS422 to USB Converter. 
3) Connect the USB A to B Cable between the RS422 to USB Converter and the computer. 

Note:  When the RS422 to USB Converter is used for the first time, it may be necessary to install the 
 applicable driver onto the computer. This may require an internet connection. 

Equipment Setup 
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3.4.2 Main Program Window 

After launching MCP-DAS, the main program window will appear. 

MCP-DAS Main Program Window 

The MCP-DAS main program window consists of the following: 

- a blank Real-Time Data tab 
- a File menu 
- an Edit menu 
- an About MCP button 
- a Dump MCP EEPROM button 
- a Real-Time Track button 
- a Full View button 
- a Snapshot + Dump MCP EEPROM button 
- a Status Bar 
- an MCP-DAS Version indicator 

3.4.3 Initiating a Connection to the MCP 

Press either the Dump MCP EEPROM button or the Real-Time Track button to initiate a connection with 
the MCP.  

The Status Bar at the bottom left hand corner of the Main Program window will indicate if a connection to 
the MCP has been established. If a connection has not been established the Status Bar will state Not 
Connected.    

Status Information 
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If the MCP-DAS fails to connect to the MCP, an error message will be displayed. Ensure that the MCP is 
powered and connected as per step 3.4.1. Once power is applied to the MCP, the MCP-DAS program will 
initiate a connection to the MCP automatically. 

Error Message, No Connection to MCP 

3.4.4 Data Tabs 

3.4.4.1 Data Layout 

Data acquired from the MCP will appear in a data tab. The name that appears on the tab will depend on 
whether the Real-Time Track, Dump MCP EEPROM, or Snapshot + Dump MCP EEPROM button was 
pressed.  

Dump MCP EEPROM Tab 

Down the left-hand side of the tab is a list of default signal names. The default signal names are TEST, 
RESET, DIM, and TEST[1] – TEST[56]. 
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Along the bottom of the tab is the Time Scale. The Time Scale is in minutes and seconds (m:s) or just 
seconds (s) if the time is less than 1 minute. The Time Scale has a maximum resolution of 0.5 seconds. 
Time increases from left to right. New events will appear at the far right side of the Time Scale. A new 
power-up event (new flight) is indicated by a vertical orange line and a time of 0 minutes. 

Time Scale

Active signals are displayed as solid blue bars by default. Momentarily placing the mouse cursor on a 
signal name or a signal bar will highlight the signal by changing the color of both the signal name and 
signal bar. 

Signals and Signal Names with TEST[37] Highlighted 

The bottom left hand corner of the Main Program Window contains status information including EEPROM 
Dump progress, connection status, and serial number of the connected MCP. 

Status Information 

3.4.4.2 Zoom and Pan 

To zoom in on a certain section of a data tab, left-click and drag the mouse cursor between any two 
points within the Time Scale at the bottom of the window. Release the left mouse button. The window will 
zoom in to display the data between the selected times. 

While zoomed in, it is possible to scroll the data, left or right, while maintaining the current level of zoom. 
This is done by clicking and holding the right mouse button within the data tab. The cursor will change to 
a cross of arrows. Now move the mouse cursor left or right. This will drag the data left or right accordingly. 
Release the right mouse button when done. 

To view all of the data within a tab, press the Full View button, or press keyboard shortcut key [v]. 
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3.4.5 Acquiring Data 

Data can be acquired from the MCP in three different ways; Real-Time Track, Dump MCP EEPROM, 
and Snapshot + Dump MCP EEPROM. 

3.4.5.1 Real-Time Track 

When Real-Time Track is pressed, MCP-DAS monitors the state of the MCP in real-time. If the MCP 
detects an event, the MCP will serially transmit the current state of all signals along with a time stamp. 
The time stamp is the time, in minutes and seconds, from the last power-up of the MCP. An event is 
defined as when a monitored signal transitions from active to inactive, or from inactive to active. 

Initially, the Real-Time Data tab will likely be blank, even after initiating a connection with the MCP. This is 
because data will not appear in the Real-Time Data tab until the MCP has experienced an event and has 
serially transmitted the data. 

Note: The MCP is designed to transmit its current state every 120 seconds. This is referred to as a 
heartbeat. The heartbeat verifies the MCP State Recorder is operating normally even in the absence of 
events. Depending on when the heartbeat occurs, the Real-Time Data tab may display the current state 
of the MCP even if no events occur. 

By default, the Real-Time Data tab zoom level will initially be locked to display the last 10 seconds. This is 
done to facilitate the viewing of events in real time. If the zoom level is subsequently changed, the Real-
Time Data tab will remain at the new zoom level. 

3.4.5.2 Dump MCP EEPROM 

Pressing the Dump MCP EEPROM button will begin the process of downloading the entire contents of 
the MCP EEPROM. The status bar at the bottom left corner of the screen displays the download 
progress. Once complete, the data will be displayed in a new tab titled EEPROM X, where X is a 
sequential number beginning with 0. 

EEPROM Dump Progress Bar 

If an error occurs during the EEPROM download, an error window will appear prompting the user to either 
retry or cancel. 

Downloading the MCP EEPROM contents does not remove or delete the data from the MCP, it is still 
retained by the EEPROM and can be re-downloaded at any time.  

Note:  Events that occur while the Dump EEPROM download is in progress will not be recorded by 
the MCP. 
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3.4.5.3 Snapshot + Dump MCP EEPROM 

Snapshot + Dump MCP EEPROM provides a convenient method of comparing Real-Time Data to Dump 
MCP EEPROM data. This could be used as a quick maintenance check to confirm that the State 
Recorder is functioning properly.   

Pressing the Snapshot + Dump MCP EEPROM button performs two functions:  
1)  Makes a copy of the current Real-Time Data and places it in a new tab titled Snapshot X.  
2)  Initiates an MCP EEPROM download and displays the data in a new tab titled EEPROM X. 

The Snapshot tab is a copy of the Real-Time Data tab, but does not update in real time like the Real-Time 
Data tab does. Therefore, events that occur after the Snapshot + Dump MCP EEPROM button is 
pressed will not be displayed in the Snapshot tab. 

The Match Zoom feature can now be used between the Snapshot tab and the EEPROM tab to compare 
the Real-Time Data to the EEPROM data. 

3.4.5.4 Match Zoom 

The Match Zoom feature allows the zoom level from one tab to be applied to another tab for the purpose 
of comparing data. Match Zoom is intended for use between the Snapshot and EEPROM tabs created at 
the time that the Snapshot + Dump MCP EEPROM button is pressed.  

How to use the Match Zoom feature: 
1)  Press the Snapshot + Dump MCP EEPROM button. A new Snapshot tab will appear which will be 

an exact copy of the Real-Time Data tab. An EEPROM Dump will also be initiated. 
2)  Once the EEPROM Dump is complete, an EEPROM tab will appear. 
3)  Left-click on the Snapshot tab. The Snapshot data will be displayed. The Snapshot tab is the 

source for Match Zoom. 
4)  Zoom to any portion of the Snapshot data.   
5)  Right-click the mouse cursor on the EEPROM tab and select Match Zoom. The EEPROM tab is 

the target for Match Zoom.  
6) Left-click on the EEPROM tab. It should now display the same data that is showing in the 

Snapshot tab. 

3.4.5.5 Data Tab Sub-Menu 

Right-clicking the mouse cursor on the Snapshot or EEPROM tab title will open a small sub-menu which 
allows the following options; Close Tab, Edit Tab Name, and Match Zoom. 

Note: The Real-Time Data tab does not have a sub-menu. 

Tab Sub-Menu 
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3.4.6 Signal Configurations and Data Export 

3.4.6.1 Signal Configurations 

The signal names and colors of inputs TEST[1] – TEST[56] can be modified by right-clicking the mouse 
cursor on the signal name. This will open a small sub-menu with the Edit Name and Edit Color options. 
  

Signal Configuration Sub-Menu 

Note: The TEST, RESET, and DIM signal names cannot be modified, but the colors may be changed. 

3.4.6.2 Data Export 

If a different method of analyzing the data is required, the data can be exported to a CSV (Comma 
Separated Values) File. Data can be exported from an individual signal or from all of the signals in the 
current tab.  

In order to reduce the CSV file size, MCP-DAS will export only the data corresponding to a signal change 
of state. For example, if the signal becomes active 5 minutes after power up, stays active for 1 minute 
and then goes inactive, the CSV file will contain 3 entries; inactive, active at 5 minutes, and then inactive 
at 6 minutes. 

The data export feature will export only the data currently shown in the tab. Therefore, if the tab is 
zoomed in to a particular section of data, the exported data will only contain that information.  

To export data from an individual signal, right-click the mouse cursor on the signal name to open the sub-
menu, and then select the Export Data as CSV option. A window will prompt for the CSV filename and 
save location. 

The CSV file will list the values from the Time Scale, and the state of the signal at that time, ‘1’ for Active, 
‘0’ for Inactive. The CSV will also contain the signal name(s), the serial number of the MCP, and the time 
and date at which the CSV export was performed.  
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Individual Signal Exported as CSV 

To export data from all of the signals, click on the File menu and select Export Data as CSV. A window 
will prompt for the CSV filename and save location.

All Signals Exported as CSV 
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3.4.7 File and Edit Menus 

3.4.7.1 File Menu 

File Menu 

The File Menu allows access to the following functions: 

Open Log 

 Opens a previously saved MCP Log File (.mlg) into a new tab. The title that appears on the tab will 
match the filename of the saved data log. 

Open Configuration 

 Opens a previously saved MCP Config File (.mcp) into the currently selected data tab. If the 
currently selected data tab is the Real-Time Data tab, the configuration of all subsequent tabs 
created as a result of pressing the Dump MCP EEPROM or Snapshot + Dump MCP EEPROM
buttons will always match the configuration of the Real-Time Data tab.  

A configuration consists of signal names and colors. 

Save Log 

 Saves all data and configuration information from the currently selected tab to an MCP Log File 
(.mlg). 

Save Configuration 

 Saves the configuration (signal names and colors) from the currently selected tab to an MCP 
Config File (.mcp). No MCP data from the currently selected tab will be saved. 

Export Data as CSV 

 Exports the data from all signals as a CSV (.csv) file. The CSV file lists the values from the Time 
Scale, and the state of the signal at that time, “1” for Active, “0” for Inactive.  

Exit 

 Closes the MCP-DAS program. 
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3.4.7.2 Edit Menu

Edit Menu 

The Edit Menu provides access to the following functions: 

Edit Serial Number 

 Changes the Serial Number of the connected MCP. The Serial Number is stored in the MCP 
EEPROM. This a factory-only feature and is password protected. 

End of Section 3.0 
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